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File menu commands

The File menu offers the following commands:

New Creates a new TaxInfo document.    Choose a sub menu 
item to bring up an index from which to select a specific 
form, schedule, publication or instruction to create.

Open Form Opens a previously saved form, schedule, publication or 
instruction document.    The extension for a TaxInfo 
document is ".TIN".

Close Closes the currently active document.
Save Save the currently active document using its current name.
Save As Names or renames the currently active document and 

saves it.    Note that the file name extension must be 
".TIN".

Save As Template Saves the currently active document as a template for new
instances of the specific form or schedule.

Print Prints the currently active form, schedule, publication or 
instruction.

Print Blanks Prints your selection of blank forms, schedules, 
publications or instructions.

Print Setup Selects a printer and printer connection.
1 File Name 1 Opens the most recently used TaxInfo document.
2 File Name 2 Opens the next most recently used TaxInfo document.
3 File Name 3 Opens the third most recently used TaxInfo document.
4 File Name 4 Opens the fourth most recently used TaxInfo document.
Exit Exits TaxInfo.



File: New sub menu commands

The File: New sub menu offers the following commands:

Forms Selects a federal tax form for display.

Instructions for Forms Selects the instructions for a federal tax form for display.

Schedules Selects a federal tax schedule for display.

Instructions for Schedules Selects the instructions for a federal tax schedule for 
display.

Publications Selects a federal tax publication for display.



Edit menu commands

The Edit menu offers the following commands:

Erase Data in All 
Fields

Erase the document.    Delete the contents of all fields in 
the document.

Erase the Current 
Field

Remove the contents of the current field.

Copy Copy the contents of the current field to the Clipboard.

Cut Remove the contents of the current field, placing it into the
Clipboard.

Paste Copy the contents of the Clipboard into the current field.
Copy All Fields Copy the contents of all fields in the document into the 

Clipboard.
Cut All Fields Remove the contents of all fields in the document, placing 

them into the Clipboard.
Paste to all fields Copy the contents of the Clipboard into all the documents 

fields.



Display Options menu commands

The Display Options menu offers the following commands:

Fit To Window 
Width

Displays the active document such that it is adjusted to fit 
within the windows width.

Max Size: No Fit Displays the active document using the maximum 
resolution of the currently selected type of bitmap.

Use Printer 
Bitmaps

Displays the active document using the 300 DPI printer 
bitmap.

Use Display 
Bitmaps

Displays the active document using the 140 DPI display 
bitmap.

Use VGA Bitmaps Displays the active document using the 90 DPI VGA 
bitmap.

No Scaling: 100% Turns off any scaling in effect.
Shrink to 50% Scales the current document 50% smaller.
Shrink to 33% Scales the current document 33% smaller.
Shrink to 25% Scales the current document 25% smaller.



Next Page command

This command will display the next page for the current window.    The menu item and 
button will be disabled if there is no next page.

Shortcuts

Mouse:
Keys: CTRL+PgDn

F8



Previous Page command

This command will display the previous page for the current window.    The menu item and 
button will be disabled if there is no previous page.

Shortcuts

Mouse:
Keys: CTRL+PgUp

F7



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get 
help.

Using Help Provides general instructions on using help.
Annotated Forms 
List

Offers an index to forms on which you can get 
information.

About Displays the version number of this application.



Exit command (File menu)

Use this command to end your TaxInfo session.    You can also use the Close command on the
application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Erase Data in All Fields command (Edit menu)

This command will remove the contents of all fields from a document.    It erases the 
contents of a document.

Shortcuts
Keys: CTRL+F



Erase the Current Field command (Edit menu)

This command will remove the contents of the current field from a document.    This 
command is unavailable if you have no fields on the current page of the document.

Shortcuts
Keys: CTRL+G



Cut command (Edit menu)

This command will remove the contents of the current field from a document and put it into 
the Clipboard.    This command is unavailable if you have no fields on the current page of the
document.

Cutting a field to the Clipboard replaces its previous contents.

Shortcuts

Mouse:
Keys: CTRL+X

SHIFT+Delete



Clipboard (description)

A temporary storage area for cut or copied field contents.    You can paste the contents of the
Clipboard into any TaxInfo document or into other applications.    The Clipboard holds only 
the last data cut or copied.



Copy command (Edit menu)

This command will copy the contents of the current field from a document and put it into the
Clipboard.    This command is unavailable if you have no fields on the current page of the 
document.

Copying a field to the Clipboard replaces its previous contents.

Shortcuts

Mouse:
Keys: CTRL+C

CTRL+Insert



Paste command (Edit menu)

This command will insert a copy of the Clipboard contents into the current field, replacing 
the field contents.    This command is unavailable if you have no fields on the current page of
the document.

Pasting a field from the Clipboard has no effect on the Clipboard contents.

Shortcuts

Mouse:
Keys: CTRL+V

SHIFT+Insert



Copy All Fields command (Edit menu)

This command will copy the contents of all fields from a document and put them into the 
Clipboard.    This command is unavailable if you have no fields in the document.

The fields are copied to the Clipboard so that each field is on a line of its own.    The 
Clipboard contents after the command is performed will contain each field terminated with 
the end of a line.

Copying all fields to the Clipboard replaces its previous contents.

Shortcuts
Keys: CTRL+H



Cut All Fields command (Edit menu)

This command will remove the contents of all fields from a document and put them into the 
Clipboard.    This command is unavailable if you have no fields in the document.

The fields are cut to the Clipboard so that each field is on a line of its own.    The Clipboard 
contents after the command is performed will contain each field terminated with the end of 
a line.

Cutting all fields to the Clipboard replaces the Clipboards previous contents.

Shortcuts
Keys: CTRL+J



Paste to All Fields command (Edit menu)

This command will insert a copy of the Clipboard contents into all fields in the document, 
replacing the contents of all fields in the document.    This command is unavailable if you 
have no fields in the document.

Each field in the Clipboard is delimited by CR,LF (carriage return, line feed) pairs.    In other 
words, each line of data of the Clipboards contents will be pasted to the next field in the 
document.    If there are more lines in the Clipboard than fields in the document, the 
remaining lines in the Clipboard are ignored.    If there are more fields in the document than 
lines in the Clipboard,    the residual fields remain the same.

Pasting all fields from the Clipboard has no effect on the Clipboard contents.

Shortcuts
Keys: CTRL+K



Forms command (File:New menu)

Use this command to select a federal tax form for viewing.    This command brings up the 
Forms Index dialog box from which you select a form and the beginning page to view.

Options that effect how a tax form are viewed are set from the Display Options menu 
commands.

Shortcuts

Mouse:
Keys: CTRL N



Form Instructions command (File:New menu)

Use this command to select a federal tax form's instructions for viewing.    This command 
brings up the Forms Instructions Index dialog box from which you select a form's instruction 
and the beginning page to view.

Options that effect how a tax form's instructions are viewed are set from the Display Options
menu commands.

Shortcuts

Mouse:
Keys: CTRL+I



Schedules command (File:New menu)

Use this command to select a federal tax schedule for viewing.    This command brings up 
the Schedules Index dialog box from which you select a schedule and the beginning page to 
view.

Options that effect how a tax schedule are viewed are set from the Display Options menu 
commands.

Shortcuts

Mouse:
Keys: CTRL+D



Schedules Instructions command (File:New menu)

Use this command to select a federal tax schedule's instructions for viewing.    This 
command brings up the Schedules Instructions Index dialog box from which you select a 
schedule instruction and the beginning page to view.

Options that effect how a schedule's instructions are viewed are set from the Display 
Options menu commands.

Shortcuts

Mouse:
Keys: CTRL+U



Publications command (File:New menu)

Use this command to select a federal tax publication for viewing.    This command brings up 
the Publications Index dialog box from which you select a publication and the beginning 
page to view.

Options that effect how a tax publication are viewed are set from the Display Options menu 
commands.

Shortcuts

Mouse:
Keys: CTRL+E



Index Dialog Box

This dialog box is used to select an item to view.    An item is selected by either clicking on 
an item in the dialog box's combo box and then pressing the OK button, or by double 
clicking an item in the combo box.

It is optionally also used to select a beginning viewing page.    The default beginning page is 
page one.    There are two ways one can select a page.    The first way is to enter a page 
number in the page combo box in the center of the lower part of the Index dialog box.    The 
other way is by clicking the arrow in the page combo box and then selecting the desired 
page from the list which drops down.



Fit To Width command (Display Options menu)

Use this command to size the document in the current window to fit in the windows width.    
Resizing of the window horizontally resizes the displayed item. You will never have any 
horizontal scroll bars with this selection.

This command and the Max Size: No Fit command. are mutually exclusive.    If it is currently 
set it will be disabled and checked.

Shortcuts
Keys: ALT+D, F



Max Size: No Fit command (Display Options menu)

Use this command to turn off the Fit To Width command.    Resizing of the window does not 
effect the resolution of the displayed item.    You will frequently have scroll bars with this 
selection.    This option is the default.

This command and the Fit To Width command are mutually exclusive.    If it is currently set it 
will be disabled and checked.

Shortcuts
Keys: CTRL+M



Use Printer Bitmaps command (Display Options menu)

Use this command to display highest resolution documents in the current window.    This 
option allows viewing of documents as they would be printed on a 300 DPI printer.

This command, the Use VGA Bitmaps command and the Use Display Bitmaps command are 
mutually exclusive.    If it is currently set it will be disabled and checked.

Shortcuts
Keys: CTRL+R



Use Display Bitmaps command (Display Options menu)

Use this command to view documents using display resolution bitmaps.    This option is 
designed to allow viewing of a document in a more manageable size for display purposes.    
It works best on displays that have resolutions of 1024 pixels wide or larger.

This command, the Use VGA Bitmaps command and the Use Printer Bitmaps command are 
mutually exclusive.    If it is currently set it will be disabled and checked.

Shortcuts
Keys: CTRL+Y



Use VGA Bitmaps command (Display Options menu)

Use this command to view documents using VGA resolution bitmaps.    This option is 
designed to allow viewing of a document in a more manageable size for VGA displays    This 
option is the default.

This command, the Use Display Bitmaps command and the Use Printer Bitmaps command 
are mutually exclusive.    If it is currently set it will be disabled and checked.

Shortcuts
Keys: CTRL+Z



No Scaling: 100% (Display Options menu)

Use this command to turn off any scaling or shrinking that is in effect.    This option is the 
default.

This command and the Shrink commands: Shrink to 50%, Shrink to 33%, and Shrink to 25%, 
are mutually exclusive.    If it is currently set it will be disabled and checked.

Shortcuts
Keys: CTRL+Q



Shrink to 50% (Display Options menu)

Use this command to shrink or scale the currently active document to 50%.    A maximum of 
four scalings may be in effect at one time.    That includes any combination of the three 
types of scaling.    A document may be scaled as small as four 25% shrinks, although it is 
doubtful if it will be readable that small.

This command and the No Scaling: 100% command are mutually exclusive.    If it is currently 
set it will be checked.

Shortcuts
Keys: CTRL+5



Shrink to 33% (Display Options menu)

Use this command to shrink or scale the currently active document to 33%.    A maximum of 
four scalings may be in effect at one time.    That includes any combination of the three 
types of scaling.

This command and the No Scaling: 100% command are mutually exclusive.    If it is currently 
set it will be checked.



Shrink to 25% (Display Options menu)

Use this command to shrink or scale the currently active document to 25%.    A maximum of 
four scalings may be in effect at one time.    That includes any combination of the three 
types of scaling.

This command and the No Scaling: 100% command are mutually exclusive.    If it is currently 
set it will be checked.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in TaxInfo, such as Forms Index and Print.    A check mark appears 
next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of TaxInfo's window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in TaxInfo.

To hide or display the Toolbar, choose the Toolbar command from the View menu (ALT, V, T).

Click To

Click on this button to create a new federal tax form or template for a 
form.    TaxInfo displays the Form Index dialog box, in which you can locate and open the 
desired form.

Click on this button to create a new instance of a form's instructions or 
a template for it.    TaxInfo displays the Form Instructions Index dialog box, in which you can 
locate and open the desired set of instructions.

Click on this button to create a new federal tax schedule or template 
for it.    TaxInfo displays the Schedule Index dialog box, in which you can locate and open the 
desired schedule.

Click on this button to create a new instance of a schedule's 
instructions or a template for it.    TaxInfo displays the Schedule Instructions Index dialog box,



in which you can locate and open the desired set of instructions.

Click on this button to create a new federal tax publication or template 
for it.    TaxInfo displays the Publication Index dialog box, in which you can locate and open 
the desired publication.

Click on this button to open an existing document (form, schedule, instruction, or 
publication) in a new window.    TaxInfo displays the File Open dialog so that you can select 
the document to open.    TaxInfo document files always have a ".TIN" extension.

Click on this button to save a document (form, schedule, instruction, or publication) 
to disk using its current name and location.    To save a document for the first time or to 
change a documents name and/or location use the Save As command.    To save a template 
for the first time use the Save As Template command.

Click on this button to remove the contents of the current field and put it in the 
clipboard.

Click on this button to copy the contents of the current field to the clipboard.

Click on this button to replace the contents of the current field with the current 
contents of the clipboard.

Click on this button to go to the next page of the document.    TaxInfo 
displays the next page of the document in the currently active window.

Click on this button to go to the previous page of the document.    
TaxInfo displays the previous page of the document in the currently active window.



Click on this button to select and print blank forms, schedules, 
instructions, or publications.    TaxInfo displays the Print Blanks Selection dialog box, in which
you can locate and print the desired items.

Click on this button to Print the current document.    TaxInfo displays 
the Print dialog box, from which one specifies how the    current form, schedule, instructions, 
or publication should be printed.

Click on this button to get help on federal tax forms.    An annotated list
of forms is available for your assistance.

Click on this button to get context sensitive help.

Click on this button to get product identification help.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the TaxInfo window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

TaxInfo displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using TaxInfo and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.

Shortcuts
Keys: ALT+H, I



Using Help command (Help menu)

Use this command for instructions about using Help.

Shortcuts
Keys: ALT+H, U



Annotated Forms List (Help menu)

Use this command to bring up Forms Help.    Clicking on a particular Form from the opening 
screen will display an annotation for that Form.

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.    Exiting Forms Help will return you to TaxInfo.

Shortcuts

Mouse:
Keys: ALT+H, F



About command (Help menu)

Use this command to display the copyright notice and version number for your copy of 
TaxInfo.

Shortcuts

Mouse:
Keys: ALT+H, A



Context Help command 

Use the Context Help command to obtain help on some portion of TaxInfo.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the TaxInfo window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut

Mouse:
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the TaxInfo window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    TaxInfo determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    TaxInfo determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.

Shortcuts
Keys: CTRL+F4 closes a TaxInfo document window

ALT+F4 closes the TaxInfo window or a dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



How to Print Tax Forms

To print a filled in federal tax form, schedule, instruction, or publication, first open the 
document using Open Form,then select Print.

To print a blank federal tax form, select Print Blanks from the file menu.    There are two steps
involved in selecting a blank form to print: setup and selection.

The first time the Print Blanks Selection dialog box comes up after TaxInfo is started, it will 
be set up for federal tax form selection by default.    That is exactly the setup required for 
this case.    Subsequently, it will be set up for what ever type of document selection was set 
up the last time it was invoked.    When the Print Blanks Selection dialog box is displayed, 
ensure that the following items are selected: the "Forms" radio button in the "Type" group, 
the "All Pages" radio button in the "Page Handling" group, and the "Print Forms" check box.

From the "Available items to print" list box in the left portion of the Print Blanks Selection 
dialog box, select the form you wish to print.    That form will be added to the "Items selected
to print" list box on the right - one entry for each page in the form.    After all the forms you 
wish to print are listed in the "Items selected to print" list box, select the Print button on the 
bottom left of the Print Blanks Selection dialog box to print those forms.

Note that TaxInfo is designed to print at 300 dpi.    Ensure that your printer is setup to print 
at 300 DPI before attempting to print with TaxInfo.    For proof copies, or other print outs of 
forms that will not be filed with the IRS you may use lower DPI settings.    A printout at a 
lower DPI setting may be of sufficient quality to file with the IRS.    Because of the variety of 
possible printers, their quality at various DPI settings, and the state of their ink situations, 
you must determine if it is of sufficient quality for filing.

For a complete description of the print selection process and the Print Blanks Selection 
Dialog, see Print Blanks.



How to Print Tax Form Instructions

To print a federal tax form instruction, select Print Blanks from the file menu.    There are two 
steps involved in selecting a form's instructions to print: setup and selection.

The first time the Print Blanks Selection dialog box comes up after TaxInfo is started, it will 
be set up for federal tax form selection by default.    Subsequently, it will be set up for what 
ever type of document selection was set up the last time it was invoked.    When the Print 
Blanks Selection dialog box is displayed, ensure that the following items are selected: the 
"Forms" radio button in the "Type" group, the "All Pages" radio button in the "Page Handling"
group, and the "Print Instructions" check box.    Also ensure that the "Print Forms" checkbox 
is not checked.    Both the "Print Instructions" and the "Print Forms" check boxes can be 
checked at the same time.    This allows one to select both forms and instructions at the 
same time.

From the "Available items to print" list box in the left portion of the Print Blanks Selection 
dialog box, select the form    whose instructions you wish to print.    That form's instructions 
will be added to the "Items selected to print" list box on the right - one entry for each page 
in the instruction set.    After all the instructions you wish to print are listed in the "Items 
selected to print" list box, select the Print button on the bottom left of the Print Blanks 
Selection dialog box to print those instructions.

Note that TaxInfo is designed to print at 300 dpi.    However, it will print at any DPI resolution 
you set up.    For print outs that will not be filed with the IRS you should select a DPI setting 
which results in a print out of sufficient quality for your purposes.    The best quality will be at
300 DPI.    For print outs that will be filed, use 300 DPI.

Instructions may also be filled out and printed.    The procedure is identical to that used for 
forms.

For a complete description of the print selection process and the Print Blanks Selection 
Dialog, see Print Blanks.



How to View and Create a New Instance of a Tax Form

To view a federal tax form, select "Forms" from the File: New sub menu to bring up the Forms
Index dialog box.    This is accomplished by clicking once with the left mouse button on "File" 
on the menu bar, then clicking once on "New" in the File menu, and finally clicking on 
"Forms" from the File: New sub menu.

As an alternative, you can instead press the  button on the tool bar to bring up
this dialog box.

Select the form you wish to view from the combo box in the Forms Index dialog box.    This is 
done by using the scroll bars on the right of the combo box to scroll through the forms list 
until you locate the form you wish to bring up.    Then click on the form you want with the left
mouse button.    Finally click on the OK button.    Alternatively, you can double-click (click 
twice in rapid succession) on the form you wish to view with the left mouse button and avoid
having to click the OK button.

Select close from the File menu to get rid of a tax form you no longer want on the screen.    If
you have entered data or in some other way modified the contents of the form, select Save 
As from the File menu to name the file in which to save the forms data and save it before 
closing it.    If you try closing a form that has been modified before saving it, TaxInfo will first 
ask you if you want to save it before proceeding with the close.

After you have saved a Form using Save As, you reopen that instance of the form with the 
Open Form command from the File menu.    Once an instance of a form has been named, you
can save it using the Save command.

For a complete description of the available indices and all their options, see File: New sub 
menu commands.



How to View Tax Forms Instructions

To view a federal tax form's instructions, select "Instructions For Forms" from the File: New 
sub menu to bring up the Forms Instructions Index dialog box.    This is accomplished by 
clicking once with the left mouse button on "File" on the menu bar, then clicking once on 
"New" in the File menu, and finally clicking on "Instructions For Forms" from the File: New 
sub menu.

As an alternative, you could instead have pressed the  button on the tool bar 
to bring up this dialog box.

Select the form whose instructions you wish to view from the combo box in the Forms 
Instructions Index dialog box.    This is done by using the scroll bars on the right of the combo
box to scroll through the forms list until you locate the form whose instructions you wish to 
bring up.    Then click on the form whose instructions you want with the left mouse button.    
Finally click on the OK button.    Alternatively, you can double-click (click twice in rapid 
succession) on the form whose instructions you wish to view with the left mouse button and 
avoid having to click the OK button.

Select close from the File menu to get rid of tax form instructions you no longer want on the 
screen.    If you have entered data or in some other way modified the contents of the 
instructions, select Save As from the File menu to name the file in which to save the 
instructions data and save it before closing it.    If you try closing instructions that have been 
modified before saving it, TaxInfo will first ask you if you want to save it before proceeding 
with the close.

For a complete description of the available indices and all their options, see File: New sub 
menu commands.



How to Enter Data in Fields

If the document does not have a template and you would like it to have one, see How to 
Create or Modify a Form's Template.    Note that many templates for forms and schedules are
provided for you.    If a template is not desired and you have not created fields for the 
document see How to Create or Modify Editable Fields.

Once fields exist for a document, either via a template or by creating them, you can edit 
them only after first getting in them.    You can get in them using one of two methods.    You 
can click on them once with the left mouse button or tab to them with the tab keys.    Once in
the field, you use the keyboard keys to type characters.    You may also use the standard set 
of keys for editing the text like the delete, backspace, home and end keys.

Data in a numeric field is right justified. A numeric field is one that contains numerals and 
optionally a decimal point, dollar sign, or comma.    All other fields are left justified.    Thus a 
numeric field will display and print its contents adjusted to right align with the end of the 
field.    While other fields will display and print their contents to left align with the beginning 
of a field.

Note that the templates provided are designed with the expectation of including a decimal 
point in a numeric field that is used for a dollar amount.    That is, the fields were created to 
align properly if one includes a decimal point followed by two digits for dollar amount fields.   
The decimal point will print out over the vertical line on the form used to separate dollars 
from cents.    It is not necessary to include two zeroes after the decimal point for whole 
dollars, TaxInfo will add them for you.

Data in a field is limited to the characters that will fit in that field.    If you want to enter more
characters than will fit in the field, modify the field to make it wider.    Fields can be modified 
once they exist, see How to Create or Modify Editable Fields.



How to Create or Modify Editable Fields

To create a field, position the mouse cursor at the point you want the field to be created and 
double click with the left mouse button.    The field will be created starting at that point with 
a default width and height.    You can now enter data into the field just created.

Fields can be resized, moved, and deleted once created.    The first step is to create a field 
edit window by clicking once with the right mouse button on the field to be resized, moved, 
or deleted.    You can then delete the field by pressing the delete key (Del).

After you have created a field edit window, moving and resizing are done in a similar manner
to moving and resizing any window in Windows.    To move it, press and hold down the left 
mouse button over the window and drag the window to its new location.    When the window 
is at its new location release the left mouse button.    To resize the window, move the mouse 
cursor to the window's boundary so that the cursor changes to a resize cursor, then press 
and hold the left mouse button to drag the boundary out to its intended size.    When finished
moving and resizing the window, click it with the right mouse button to conclude your 
editing.    You may alternatively click with the right mouse button on a different field to 
remove the current field editing window and create one for the other field.

For a description of how to enter data in fields once created, see How to Enter Data in Fields.



How to Create or Modify a Form's Template

A template is a set of fields and their contents or data designed for a particular document.    
Whenever a new document is opened, the template is applied to define the documents fields
and any default data for those fields.    A template is created or modified for a particular 
Form, Schedule, Instruction, or Publication by the command Save As Template.

In a template the fields may or may not have data in them.    In most cases the fields in a 
template will be blank (as in the templates supplied).    You may want to modify these 
templates so that every time you create a new form using the command New certain fields 
are already filled in.

Any document can have a template: Forms, Schedules, Instructions or Publications.    
Templates are supplied for many forms and schedules.

A template can be edited after it is opened.    An easy way to open a template is by using the
New command from the file menu, just as one would create a normal new document.    The 
only difference, other than intent, between editing a template and creating a new document 
is how it is saved.    For a template one saves with the Save As Template command, for a 
document one saves using the command Save As.    Save As Template already knows where 
in your install directory and what name to use to save as a template.    The Save As 
command needs to ask you for that information.

One creates or edits fields in a template in exactly the same way as for documents, see How
To Create or Modify Editable Fields.







Open Form command (File menu)

Use this command to open an existing form, schedule, instruction and/or publication 
document.    This command presents a File Open dialog box, where you may select the 
particular TaxInfo (*.tin) document you wish to open.

Note that you create a new TaxInfo document by selecting one of the File menu New 
subcommands and then save it using the Save As command with a ".TIN" extension for the 
file name

Shortcuts
Keys: CTRL+O



Close command (File menu)

Use this command to close the window containing the active form, schedule, instruction or 
publication document.    TaxInfo suggests that you save changes to your document before 
you close it.    If you close a document without saving, you lose all changes made since the 
last time you saved it.    Before closing an untitled document, TaxInfo displays the Save As 
dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:

Shortcuts
Keys: CTRL+C



Save command (File menu)

Use this command to save the active form, schedule, instruction, or publication document to
its current name and directory.    When you save a document for the first time, use the File 
menu Save As command so you can also name your document.    If you want to change the 
name and/or directory of an existing document before you save it, choose the Save As 
command.

Shortcuts
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active form, schedule, instruction or publication 
document.    TaxInfo displays the Save As dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.

Shortcuts
Keys: CTRL+A



Save As Template command (File menu)

Use this command to save the active form, schedule, instruction, or publication document as
a template.    After a template exists for a document, when you bring up a new instance of 
the document, the fields and data saved in the template will automatically be included in the
new document.

Many templates for forms and schedules are provided for you.    To change any of these 
templates, open the corresponding ".TIN" file residing on the CD in the "TEMPLATS" directory.
When your editing is complete, select Save As Template and TaxInfo will save your edited 
template in the "TEMPLATS" directory in the installation directory.    Any templates you 
modify or create and then "Save As Template" will be the template used.    When TaxInfo 
looks for a template, it first looks in the "TEMPLATS" directory under the install directory and 
then on the CD.    The first template found is the one used.

Shortcuts
Keys: CTRL+T



Print command (File menu)

Use this command to print the active form, schedule, instruction or publication document to 
the printer.    This command presents a Print dialog box, where you may specify the range of 
pages to be printed, the number of copies, the destination printer, and other printer setup 
options.

Note that TaxInfo is designed to print at 300 dpi.    At any other setting TaxInfo will still print, 
however the form may not be of sufficient quality to file with the IRS.    To print a file-able tax
form or schedule print at 300 dpi.    For proof copies or other print outs that will not be filed, 
you may print at any other DPI setting.

Shortcuts
Keys: CTRL+P



Print Blanks command (File menu)

Use this command to print a selection of blank forms, schedules, instructions and/or 
publications.    This command presents a Print Blanks Selection dialog box, where you may 
specify the particular items you wish to print.

Note that TaxInfo is designed to print at 300 dpi.    At any other setting TaxInfo will still print, 
however the form may not be of sufficient quality to file with the IRS.    To print a file-able tax
form or schedule print at 300 dpi.    For proof copies or other print outs that will not be filed, 
you may print at any other DPI setting.

Shortcuts

Toolbar:
Keys: CTRL+T



Print Blanks Selection dialog box

The objective is to build a list of items to print in the "Items selected to print" list box.
The "Items selected to print" list box is the right most list box that is empty when the dialog 
box first comes up.    When the "Items selected to print" list box contains all the items you 
wish to print, press the Print button on the bottom left of the Print Selection dialog box to 
send those items to be printed.

You add items to the "Items selected to print" list box by clicking with the left mouse 
button on an item listed in the "Available items to print" list box. This list box is the left most 
and is filled with items available to print when the Print Selection dialog box first comes up.   
Scrolling up and down is available to reach an item further up or down in the list.    You can 
also scroll left and right to read the items annotation.

You delete items from the "Items selected to print" list box by clicking with the left 
mouse button on an item.    You may also delete all the items contained in the "Items 
selected to print" list box by clicking the "Clear all items selected to print" button located 
directly below the "Items selected to print" list box.

The two sets of radio buttons on the top of the Print Selection dialog box control the 
type of items listed in the "Available items to print" list box and how pages are handled 
when an item is selected from the "Available items to print" list box.    When the "Form" radio
button in the "Type" group is selected, forms are listed in the "Available items to print" list 
box.    When the "Schedules" radio button in the "Type" group is selected, schedules are 
listed in the "Available items to print" list box.    When the "Publications" radio button in the 
"Type" group is selected, publications are listed in the "Available items to print" list box.    
When the "All pages" radio button in the "Page Handling" group is selected, all the pages for 
the particular item you select in the "Available items to print" list box are added to the 
"Items selected to print" list box.    When the "Select pages" radio button in the "Page 
Handling" group is selected, each available page for an item is listed in the "Available items 
to print" list box, thus allowing you to select individual pages one at a time to add to the 
"Items selected to print" list box.

The two check boxes below the "Available items to print" list box are used to control 
the selection of instructions.    When the check box "Print Forms" is checked a selection from 
the "Available items to print" list box will add those items to the "Items selected to print" list 
box.    When the check box "Print Instructions" is checked a selection from the "Available 
items to print" list box will add the instructions for the item to the "Items selected to print" 
list box.    If they are both checked both the item and its instructions will be added to the 
"Items selected to print" list box.    Note that some items do not have any instructions (they 
may be included in the item itself).    Publications never have any instructions so when the 
radio button "Publications" is selected in the "Type" group the two check boxes are disabled 
(grayed).

The action taken when a button is pressed follows:
Clear all items selected to print

Causes all items listed in the "Items selected to print" list box to be cleared or deleted 
from the list box.    Pressing this button causes the selection process to start over.    Note 
that individual items can be cleared in the "Items selected to print" list box by clicking on
them.

Print
Causes all items listed in the "Items selected to print" list box to be printed.    Choose the 
Print Setup button to change the printer and printer connection.



Print Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Cancel
Cancels the entire Print Selection dialog.    The dialog box disappears.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Although you may choose Portrait or Landscape, TaxInfo is designed to work in Portrait 
orientation only.

Paper Size
Although you may select the size of paper to be printed on, TaxInfo is designed for 8.5" x 
11" paper.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. TaxInfo files have a ".TIN" extension. 

List Files of Type
Select the type of file you want to open:
TaxInfo expects an extension of "TIN" file type.

Drives
Select the drive in which TaxInfo stores the file that you want to open. 

Directories
Select the directory in which TaxInfo stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 
This button only appears if there is a network installed.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    TaxInfo adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 
This button only appears if there is a network installed.



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.    
Not choosing Collate Copies will result in faster printing.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Most Recently Used File command (File menu)

Use this command to open one of your last four most recently used documents.    Clicking 
once with the left mouse button on one of the items in the MRU (most recently used) list will 
bring up a window with that form, schedule, instruction or publication in it.    Optionally you 
may use the keyboard as indicated below in "Shortcuts" where the number corresponds to 
the order of the file in the MRU list.

When TaxInfo is initially installed, there will be only one item in the MRU.    That item, 
SMPL1040.TIN, is an example of a completely filled in Form 1040.    It will have a "1" prefixing
it.    Thus, one may bring up SMPL1040.TIN either by clicking on it once with the left mouse 
button, or by holding down the Ctrl key while pressing the number 1.

Shortcuts
Keys: CTRL+1

CTRL+2
CTRL+3
CTRL+4






